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This document was developed as part of the continuing effort to provide guidance within the 
Georgia Department of Transportation in fulfilling its mission to provide a safe, efficient, and 
sustainable transportation system through dedicated teamwork and responsible leadership 
supporting economic development, environmental sensitivity and improved quality of life. 
This document is not intended to establish policy within the Department, but to provide 
guidance in adhering to the policies of the Department. 

Your comments, suggestions, and ideas for improvements are welcomed.  

 

Please send comments to: 

State Design Policy Engineer 

Georgia Department of Transportation 

One Georgia Center 

600 W. Peachtree Street, 26th Floor 

Atlanta, Georgia 30308 

 

DISCLAIMER 

The Georgia Department of Transportation maintains this printable document and is solely 

responsible for ensuring that it is equivalent to the approved Department guidelines. 

 

 

 

 



OpenRoads Survey Data Processing Guidelines   

 

   Page i 

Revision Summary 

Revision Number Revision Date Revision Summary 

1.0 4/23/20 Original Release Date 

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   

   



OpenRoads Survey Data Processing Guidelines   

 

   Page ii 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Intentionally Left Blank 

 

 



OpenRoads Survey Data Processing Guidelines   

 

Rev. 1.0                                                                                                                                                                     Preface 

4/23/20                                                                                                                                                                        Page iii 

Preface 

Survey Data Processing consists of verifying, coordinating, formatting and processing full field survey 

data, field mapping enhancement data, additional survey data and existing right of way and property 

data. This data is then submitted to end users as OpenRoads Designer Connect Edition (DGN) files 

that may also contain Topographic 3D Digital Terrain Models and Geometry. The digital field/mapping 

data is used as a database in the development of highway project plans. 

These Survey Data Processing Guidelines have been developed as part of the statewide GDOT 

implementation of OpenRoads Designer Connect Edition, aka ORD. The intent of this document is to 

provide guidelines and standards for processing survey data in ORD. These guidelines must be 

followed in detail in order to conform to the current GDOT standards for producing the required survey 

data deliverables. Updates to this document will be made periodically when minor revisions, additional 

information, and/or enhancements are added. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If there is any approved deviation from the standard file and data naming/feature style conventions 

as prescribed by this document - a detailed description of the deviation(s) and approved reasons 

for the deviation(s) shall be documented and included with the project files in electronic format. 
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Contact Information 

To submit any comments or questions regarding the information contained in this document, please 

contact the Office of Design Policy & Support by email at the following address: 

SolutionsCenter@dot.ga.gov 

In the Email Subject Header, please reference the OpenRoads Survey Data Processing 

Guidelines. 
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Overview 

These Guidelines cover the GDOT standards for processing Survey Data by use of ORD software. 

These guidelines delineate the Standard Conventions required in the generation of DGN files that 

provide graphic representations of existing terrain models, existing property and existing utilities in 

accordance with GDOT formatting requirements. The DGN files generated as recommended in these 

guidelines are to be submitted as deliverables to the Project Manager for dissemination to the 

appropriate design staff. 

For detailed Survey Data Processing instructions please refer to Bentley Learn Server related 

Training Materials.  Listed below are recommended learning paths to follow before working in ORD. 

To become familiarized with the general ORD Designer Ribbon Interface, all users should go 

through the QuickStart – Navigating the Interface training in the 00 – OpenRoads Designer – 

Roadway Design & Modeling – Fundamentals Learning Path: 

https://learn.bentley.com/app/Public/ViewLearningPathWithMasterCourseExpanded?lpId=113539&

mcId=102986. 

 

Document Content  

Below is a list of topics covered in this document: 

• Standard Conventions 

• Survey Data Project Deliverables 

 

Related Documents 

Below is a list of documents that contain additional information that is pertinent to the production of 

the previously mentioned deliverables: 

• OpenRoads Field Survey Feature Codes 

• OpenRoads Photogrammetric Features 
 

 

 

 

 

 

 

 

 

 

 

 

 

https://learn.bentley.com/app/Public/ViewLearningPathWithMasterCourseExpanded?lpId=113539&mcId=102986
https://learn.bentley.com/app/Public/ViewLearningPathWithMasterCourseExpanded?lpId=113539&mcId=102986
https://learn.bentley.com/app/Public/ViewLearningPathWithMasterCourseExpanded?lpId=113539&mcId=102986
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Chapter 1. Standard Conventions 

This section provides an overview of the GDOT standard Project, File and Object naming 

conventions. The standard Feature Types for Terrain Model are discussed in this section. Feature 

Code Tables which provide the standard Feature Codes/Feature Definitions to utilize for 

Photogrammetric and/or Field Survey Projects are also listed. 

This section covers the following topics:  

• Project, File and Object Naming Conventions 

• Standard Terrain Model Feature Object Names 

• Standard Terrain Model Feature Types 

• Standard Geometry Object Names 

• Standard File Information 

• GDOT Standard ORD Photogrammetry Feature Codes 

• GDOT Standard ORD Field Survey Feature Codes.. 

1.1. Project, File and Object Naming Conventions 

As mentioned previously - in order to ensure Project and File Naming consistency – standard Project, 

File and Object Naming conventions have been established. 

This section details the following Standard Naming Conventions: 

• Standard Project Naming Conventions 

• Standard File Naming Conventions 

• Standard Object Naming Conventions 

** Important Conventions regarding CSV File Import: 

ORD contains file importing functionality that facilitates importation of CSV file(s) with the appropriate 

formatting for use in ORD.  The .CSV file is imported based on a Point Number, Northing, Easting, 

Elevation, Feature Code and Attribute format set automatically in the GDOT Workspace by the 

GDOT default TIW file as follows: 
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After the CSV file(s) are imported into the Field Book, the data can then be used to generate a Terrain 

Model, annotated and exported to create a separate UTLE file. 

1.1.1 Standard Project Naming Conventions 

The standard folder structure for ORD projects in ProjectWise is as follows:  

pw:\\gdot-go-pwis01.gdot.ad.local:ProjectWise\Documents\Projects\PI# - County – Description\PE 

(Preconstruction)\Location Database\Survey\SLB District Surveys\SLB DGN-CE\ 

An example is as follows: 
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pw:\\gdot-go-pwis01.gdot.ad.local:ProjectWise\Documents\Projects\0013379 - Butts - Op 

Improvements - SR 36 Conn\PE (Preconstruction)\Location Database\Survey\SLB District 

Surveys\SLB DGN-CE\ 

The SLB DGN-CE folder is the folder location where the core of the Survey File data is stored.  When 

submitting project deliverables for use by the Design Office a link to the appropriate file(s) in the SLB 

DGN-CE folder must be submitted to the Project Manager. 

Table 1.1 

Standard Project Naming Conventions 

ORD ProjectWise 

Project Structure 

pw:\\gdot-go-pwis01.gdot.ad.local:ProjectWise\Documents\Projects\PI# - 

County – Description\PE (Preconstruction)\Location Database\Survey\SLB 

District Surveys\SLB DGN-CE\ 

ORD  

ProjectWise 

Project Structure 

(Example) 

pw:\\gdot-go-

pwis01.gdot.ad.local:ProjectWise\Documents\Projects\0013379 - Butts - Op 

Improvements - SR 36 Conn\PE (Preconstruction)\Location 

Database\Survey\SLB District Surveys\SLB DGN-CE\ 

 

1.1.2 Standard File Naming Conventions 

ORD relies on several different types of files to generate the required deliverables but much of the 

work done by the SDE will involve CSV files (input data delivered to the SDE) and DGN files (delivered 

to the designer by the SDE). Following are the applicable file naming conventions (See Table 1.2) 

 Table 1.2 

 Standard File Naming Conventions 

 File Type File Name 

   

 CSV –Field Survey File 
 

1st (Original) Field Survey CSV 

2nd Enhancement Field Survey CSV 

3rd Enhancement Field Survey CSV, Etc. 

 
 

PI#A.csv 

PI#B.csv 

PI#C.csv, 

Etc. 

 Processed DGN Files PI#MAP.dgn 

PI#SURV.dgn 

PI#TOPO.dgn 

PI#UTLE.dgn 
PI#PROP.dgn 
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1.1.3 Standard Object Naming Conventions 

ORD contains several different object types such as Terrain Model Feature Points and Alignments. 

Following are the applicable object naming conventions (See Tables 1.3 – 1.5). 

Table 1.3 

Example Standard Object Names 

Object Type Object Name Object Name Convention 

Feature Points  Example: 1789 --- (No Prefix) Point Number 

Baseline Alignments Example: SR10-US78 

Example: CR201 

Example: CS112 

Example: Main St 

Example: North Ave 

SR10-US78 

CR201 

CS112 

Main St 

North Ave 

Non-Baseline Alignments Example: SV23--- (SV Prefix) SV Prefix + Number 

 

Table 1.4 

Example Exterior Boundary Naming Conventions 

Exterior Boundary Type Feature Name Feature Style 

Mapping Exterior Boundary XBOUNDARY TOPO_E_TLIML 

Full Field Survey Boundary XBOUNDARY TOPO_E_TLIML 

 

NOTE: An exterior boundary workflow is demonstrated at the following link: 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/2271
8/video-boundary-options 

 

Table 1.5 

Point & Alignment Specifications 

 

Points Point number only, with no prefix and no range limit. 

Alignments (baseline) Alignments will have no range limit and will always be assigned 

names that coincide with the name of the roadway delineated 

by the alignment (SR10-US78 and MainSt for example). 

Alignments (non-baseline) Non-baseline Linear Geometry will have no range limit and will 

always have the SV Prefix. 

 

 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/22718/video-boundary-options
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/22718/video-boundary-options
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1.2 Standard Terrain Model Feature Objects 

Names Mapping and Field Data: 

Upon receiving the PI#MAP.dgn file from Photogrammetry the file must be copied and renamed to 

PI#SURV.dgn.  The PI#SURV.dgn file should then be used to create the Terrain Model and store the 

existing geometry.  The GDOT Location graphical filter is available for implementation in creating the 

terrain model via the Create Terrain by Graphical Filter Tool.  

The CSV (Field Data Collector) files are imported directly into ORD by right clicking on the appropriate 

field book and selecting the Import, File options. After the CSV file is imported into the Field Book, 

the data can then be used to create/enhance existing Terrain Models, view existing topography, view 

existing utility resources, view property related items, and perform other related tasks as needed.  

As the CSV data is imported the alpha codes are used to assign the feature names/definitions to the 

feature objects – Example: TPBL1, TPBL2, TPBL3, etc. for Field Survey terrain model data. The 

internal Terrain Model points are numbered consecutively in the Feature Objects - Example: 1, 2, 3, 

etc. Each Feature can be made up of one or many points. The Feature definition is based on the 

associated Alpha codes and is assigned during the CSV Import process. The Feature Type 

determines if the Feature will be included in the triangulation process. 

The Feature Type affects how the DTM triangles are formed. The Feature Type can be a breakline, 

spot, contour, void or boundary and is determined based on a setting in the corresponding Feature 

Definition. The attribute of the Terrain Model Feature  and the triangulation effect is also determined 

by feature definition. 

The Standard Object Names for the Terrain Model Features are determined by the Feature Code– 

this is an automated process so that the Standard Object Names are already defined for the user. 

1.3 Standard Terrain Model Feature Types 

The five ORD Feature Types designated for use on GDOT projects are Breakline, Spot, Contour, 

Void and Boundary. These Feature Point Types are set as part of the GDOT Workspace.  As 

mentioned previously, the Feature Point Type determines how Terrain Model triangles are formed 

when the points are connected.  When the data in the CSV file is imported the correct Feature Type 

is automatically assigned by the Feature Definition and to the Feature Object which is imported into 

the Terrain Model. Following are examples of the Feature Types: (See Table 1.6) 
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Table 1.6 

Example Terrain Model Feature Types 

Feature Type Description 

Breakline Linear connected points that represent 
discontinuities in a surface 

Spot Randomly spaced points that are independent of 
other points 

Contour Connected points that form a linear segment 
based on elevation 

Void Interior connected points that represent areas in a 
Terrain Model that are undefined or obscured 

Boundary Exterior connected points that represent the outer 
limits of a Terrain Model surface and can be used 
to trim extraneous triangulated data 

 

1.4 Standard Geometry Object Names 

As mentioned previously – The CSV (Field Data Collector) files are imported directly into ORD by 

right clicking on the appropriate field book and selecting the Import, File options. The Geometry 

related survey data including the Property data, Existing Right of Way, Alignment data and etc. are 

included in the ORD Model.  

LEVEL Filters consisting of the EXIST ALIGNMENTS, EXIST PROPERTY and EXIST RDWY TOPO 

filters have been included for the purpose of simplifying tasks that involve viewing and isolating 

existing alignment, property and topographical items. 

 

  



 OpenRoads Survey Data Processing Guidelines   

 

Rev 1.0                                                                                                                                           1. Standard Conventions 

4/23/20                                                                                                                                                                     Page 1-7 

SURVEY Filters for use in quality checks and other tasks have been included in the GDOT ORD 

Workspace via the GDOT_ORD_3D seed file.  In future releases these filters will be supported via 

DGNLIB file.  When the GDOT_ORD_3D seed file is used to create the DGN file and survey data has 

been imported into a field book the filters will be available in the Survey Tab of the Explorer and can 

be navigated to by selecting the down arrows as follows: 

 

Each filter turns on specific features.  The functionality of these filters is most easily tested by turning 

off all features and turning each filter on and off one at a time. 
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A. Geometry Object Names: 

 

The Geometry Objects consist of points, linear geometry and alignments. Existing property data is 

imported from the Field Survey CSV file. The SDE then utilizes deeds, plats, existing plans or tax 

maps if required to assist in the input of the parcel and alignment data. The SDE will store property 

data by utilizing the existing points imported from the CSV file and by storing additional points, linear 

geometry and alignments computed by use of information from deeds, plats and etc. as needed. 

Please Note: 

The points/chains imported from the CSV file will contain No prefixes. The SDE will also store any 

computed points with No prefixes. Any baseline (PROP_E_ACL) alignments will be assigned names 

that coincide with the name of the roadway delineated by the alignment (SR10/US78 and MainSt for 

example).  Other computed (non-baseline) alignments will be stored with an SV prefix + number to 

represent survey stored Linear Geometry features such as property, existing R/W, Land Lot Lines, 

etc.  Points will be stored with nothing more than the point number (no prefix). 

*The reason that Survey (field collected and computed points) do not contain pre-pended prefixes is 

to help differentiate between survey and design data. Designers will name their computed points and 

alignments with a pre-pended DE prefix in order to differentiate between Survey and Design 

points/alignments.  

The above Naming Scheme is utilized in order to differentiate between Survey Data and Design Data. 

The Naming Scheme is also used to assist in adding Additional Survey Enhancement information to 

a database. This information can then be submitted to the Designer so that the Designer’s Points and 

Alignments will not be overwritten when additional enhancements are added to the Designer’s 

Geometry Project Database. (See Table 1.7) 

Table 1.7 

Example Standard Object Names 

Baseline Alignments Example: SR10-US78 

Example: CR201 

Example: CS112 

Example: Main St 

Example: North Ave 

Road/Street Name/Number 

Road/Street Name/Number 

Road/Street Name/Number 

Road/Street Name/Number 

Road/Street Name/Number 

 

Non-Baseline Alignments Example: SV23--- (SV Prefix) SV Prefix + Point Number 

Points Example: 1477--- (No Prefix) Point Number only (no prefix) 
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B. Feature Definitions required for use in storing Points and Alignments: 

The Standard Feature Definitions to use when storing Points and Alignments for the Existing Baseline 

Alignments, Existing R/W, Property, etc. will be named according to the type of Point or Alignment 

which is to be stored. The following Table lists the applicable Feature Style(s) to utilize when storing 

the Point and Alignment data: (See Table 1.8) 

Table 1.8 

Feature Styles for Points and 
Alignments 

 PROP_E_ACL-PC-PT PROP_E_PPC 

 PROP_E_APC PROP_E_PPOL 

 PROP_E_API PROP_E_RWC 

Existing/Computed Points PROP_E_APOC PROP_E_RWE 

 PROP_E_APOT PROP_E_RWM 

 PROP_E_APT PROP_E_RWRR 

 PROP_E_PCF PROP_E_RWU 

 PROP_E_RWE-LTD-

ACCESS 

PROP_E_LTD-ACCESS 

Existing Baseline Alignment PROP_E_ACL 

Existing R/W Alignment PROP_E_RWE 

Existing Property (Parcel) Alignment PROP_E_PAR 

Existing R/W & Limited Access 
Alignment 

PROP_E_RWE-LTD-ACCESS 

Existing Limited Access Alignment PROP_E_LTD-ACCESS 

 

1.5 Standard File Information 

Following is a brief overview of the most common file types the SDE will process and generate: (See 

Table 1.9) 
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Table 1.9 

Standard File Information 
Overview 

 
CSV 

The .CSV files are comma delimited ASCII format files and contain Field Survey Data collected utilizing Data 
Collectors in the field (Topography, Property, Drainage, etc.). The .CSV file is imported into the ORD Field Book. 

 
PI#SURV.dgn 

This DGN file contains the mapping data imported from the PI#MAP.dgn file provided by the Photogrammetry 
Office. 

 
PI#TOPO.dgn 

This DGN file contains all the Topographical and Drainage information generated from Mapping and Full Field 
Survey. 

 

 
PI#UTLE.dgn 

This DGN file contains all the Utility information generated from Field Survey Data and Mapping. 

 
 

 

 
 

1.6 GDOT Standard OpenRoads Photogrammetric Feature Codes 

To see the most current GDOT OpenRoads Photogrammetric Features and the Levels used for them, 

please see the OpenRoads Photogrammetric Features document, found on the GDOT ROADS 

webpage. 

1.7 GDOT Standard OpenRoads Field Survey Feature Codes 

To see the most current GDOT OpenRoads Survey Feature Codes/Styles, please see the 

OpenRoads Field Survey Feature Codes document, found on the GDOT ROADS webpage. 

 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/InRoads%20Photogrammetric%20Features.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/InRoads%20Field%20Survey%20Feature%20Codes.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/InRoads%20Field%20Survey%20Feature%20Codes.pdf
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Chapter 2. Survey Data Project Deliverables 

This section provides an overview of the Survey Data Project Deliverables which will be submitted 

to the Office of Design Policy and Support/Location Bureau (Engineering Management / Operations 

Manager). This data will then be forwarded to the Designer. 

2.1 Processing of the Mapping and/or Full Field Survey Surface (Terrain Model) 

Once the Terrain Model has been created (either by use of the Graphical Filter, ‘GDOT_Location’ for 

Mapping Projects or by creation from the Field book for Full Field Survey Projects) it should be 

reviewed for errors.  The following items should be checked to ensure a correct Terrain Model is submitted. 

Terrain Model Review Checklist: 

 

2.2 Processing of the Geometry 

Once the Geometry has been created it should be reviewed for errors. The following items should be 

checked to ensure no errors are submitted. 

Geometry Review Checklist: 

 

  

 Verify that only GDOT Naming Conventions and Feature Definitions are used 

 Make sure that all crossing segments and crossing overlaps are resolved 

 Check to ensure there are no erroneous (bad) point elevations 

 Verify that the Terrain Model contains no erroneous “Spikes” 

 Verify the Terrain Model is assigned the Feature Definition of Existing Boundary 

 For Full Field Survey projects, ensure there is only one Exterior Boundary and that it 

is assigned a feature definition of TLIML with model attribute = Boundary  

 For Mapping projects, the Edge Method must be used to create the XBOUNDARY 

and set to Max Triangle Length with a Maximum Triangle Side Length of 100.00’. 

 Verify that all Interior Boundaries are closed shape entities 

 Make sure to compress the DGN file before submittal. 

 Verify that only GDOT Naming Conventions and Feature Definitions are used 

 Point Prefixes shall not be utilized by the Surveyor/SDE. 

 All roadway alignments are named correctly utilizing the name of the road. 

 All alignments other than roadway alignments have an SV Prefix followed by 

incrementing numbers. 

 All parcels must be stored clockwise, and the alignments must close (first and last 

point number must be the same). 
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2.3 Generation of the Topographical, Property and Utility DGN File(s) 

After the final processing of the PI#SURV.dgn, the PI#TOPO.dgn and PI#UTLE.dgn will be generated 

for submission to Design.  In the end the PI#TOPO.dgn shall contain only topo and property 

information and no utility information.  The PI#UTLE.dgn shall contain only utility information and no 

topo or property information. 

 

Table 2.1 

Standard DGN File Names 

Survey DGN File Name PI#SURV.dgn 

Topographical DGN File Name PI#TOPO.dgn 

Utility DGN File Name PI#UTLE.dgn 

 

Before submitting the DGN Files – perform the following steps  

For each DGN File - “Fit the Active View” so that all the data appears in the ORD View 

Window. 

The process of generating the PI#TOPO.dgn and PI#UTLE.dgn is briefly summarized as 

follows: 

1. While the PI#SURV.dgn file is active select File>Save As from the ORD Ribbon in the 

PI#SURV.dgn file. 

2. Save the DGN File (Example: 1234567TOPO.dgn, indicated in table 2.1) to the appropriate 

folder. 

3. In the [ORD Software] – 

Select File>Tools>Compress Options>Compress>Ok  from the ORD Ribbon.  Leave the 

Include References box unchecked but check all others (This will compress and reduce the 

size of the file size). 

4. Select File>Save As from the ORD Ribbon in the PI#TOPO.dgn file. 

Save the DGN File (Example: 1234567UTLEXPORT.dgn) to the appropriate folder. 

5. In the 1234567UTLEXPORT.dgn file: 

Turn off all UTLE levels, turn on all non-UTLE levels and select/delete all non-UTLE items.  

Turn the UTLE levels back on. 

Right click on the fieldbook, select the Export to DGN Graphics option, enter the PI#UTLE.dgn 

(1234567UTLE.DGN) in the file name field and select the Save option. 

Review the PI#UTLE.dgn file, “Fit the Active View” and save the settings.  After successfully 

reviewing the PI#UTLE.dgn file the 1234567UTLEXPORT.dgn file can be deleted. 

6. In the 1234567TOPO.dgn file: remove all utility information. 
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When all associated DGN files are ready, the SDE is instructed to contact the Project Manager and 

make copies available on ProjectWise. For projects not in ProjectWise, a request shall be made to 

the Office of Design Policy & Support to add the project to ProjectWise. All files shall be saved in 

locations according to established ProjectWise procedures. The Project Manager will inform the 

designer when the files are available for use in ProjectWise.  

Important: In order to be approved by GDOT, ALL Survey Databases shall be reviewed prior to 

submittal using the OpenRoads Survey Data Processing QA Checklist available for download from 

the GDOT ROADS webpage.  http://www.dot.ga.gov/PS/DesignSoftware/OpenRoads 

2.4 Listing of the SDE Project Deliverables 

After the Terrain Model and Geometry have been processed and thoroughly reviewed using the 

OpenRoads Survey Data Processing QA Checklist, along with all other Project Deliverables, and 

have been approved by GDOT, the files will be sent to the Project Manager. This data will then be 

forwarded to the Designer. 

The Final Deliverables include the following: 

• PI#TOPO.dgn (Existing Topo features, and existing property information) 

• PI#UTLE.dgn  (Existing Utility features) 

• PI#PSR.xls (Property Statistics Report) 

• PI#Misc.txt  (Miscellaneous  information  SDE  deems  important.  This file may not be 

included.) 

• A Survey Data Processing ORD Quality Assurance Checklist Document 

• Property Research (scanned PDF of deeds, plats, tax maps, etc.) 

• Survey Control package 

• Hydraulic Engineering Field Report 

• Bridge Hydraulics Study (if applicable) 

• Septic Tank Report 

• Any comments addressing potential issues of the survey 

 

PLEASE NOTE: 

A Survey Data Processing OpenRoads QA Checklist will be documented by the District SDE and/or 

Office of Design Policy and Support/Location Bureau and/or the Consultant Firm performing the 

Survey Data Processing work. This document lists several areas including the Survey Data, Terrain 

Model, Geometry Data and Final Deliverables which need to be verified before Project Submittal. 

This Document is a required Deliverable and must be submitted with the previously listed Deliverables.  

 

 

http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Survey_Data_Processing_InRoads_QA.pdf
http://www.dot.ga.gov/PS/DesignSoftware/InRoads
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Survey_Data_Processing_InRoads_QA.pdf
http://www.dot.ga.gov/PartnerSmart/DesignSoftware/INROADS/Survey_Data_Processing_InRoads_QA.pdf
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